
chapter

6
HTML Coding

“From then on, when anything went
wrong with a computer, we said it had
bugs in it.”

—Grace Murray Hopper, on the removal of

a moth from a computer in 1945
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In this chapter, you will
learn how to:

■ Explain the concept of a markup
language and define the HTML
tags you will use to create your
Web page résumé.

■ Create a new HTML file and
use paragraph, list, and anchor
tags to format the text and
create the bookmark links on
your Web page résumé.

■ Capture and convert images
into a file format suitable for
display on a Web page, and use
the HTML image tag to put a
graphic on your Web page
résumé.

■ List the HTML table tags, create
a table-driven page layout, and
flow text and graphics into the
cells of the table onscreen.

■ Define the hypermedia design
paradigms you can use to link
pages into well-structured
Webs that enable users to
navigate efficiently.

TH I S may be the most empowering chapter in the book because it
steps you through the process of creating an HTML Web page. After defin-
ing the HTML codes and understanding how they mark up the content of
a Web page, you use these codes to create a very strategic Web page—your
résumé, which will come in handy any time you are looking for a job.

To make your résumé easy to navigate, you will learn how to divide a
page into sections and create a table of contents. By linking the items in this
table to the various sections of your résumé, you will enable potential em-
ployers to navigate your page and learn about your job skills. In the pro-
cess, your well-constructed résumé will demonstrate your Web creation
skills, which employers consider strategic in the twenty-first century infor-
mation economy.

To illustrate your résumé, you learn how to put graphics onto a Web
page. If you do not have these graphics already at hand, the chapter
teaches you how to capture graphics and convert them into a format suit-
able for displaying on a Web page.

Then you use tables to control the positioning of text and graphics
onscreen. You learn HTML tags that enable you to create layouts consist-
ing of any conceivable pattern of table cells onscreen. These are the same
table tags that all the major sites use to create their screen layouts, such as
Amazon, CNN, eBay, Google, Yahoo!, and the Library of Congress.

After learning how to design individual pages, you learn how to form
Webs by hyperlinking the pages together. By creating different patterns in
your links, you create hypermedia design structures that enable users to
navigate your Webs efficiently. By learning how to create different kinds of
hypermedia design patterns, you will become very powerful as a Web page
designer.

How HTML Works

Hypertext markup language (HTML) is the markup language used to
create hypertext documents for the World Wide Web. The key to under-
standing how HTML works is to know what it means to mark up a text.
Once you understand the markup concept, you will be ready to learn the
HTML tags.



Understanding Markup

To mark up a text means to insert special codes called tags into the text.
The tags control how the text appears on a Web page. For example, com-
pare Figures 6-1 and 6-2. In Figure 6-1, you see how a text appears on a
Web page; notice the different-sized heading, the paragraphs, and the list
of bulleted items. In Figure 6-2, you can see the HTML tags that mark up
the text. By comparing these two figures, you can begin to understand how
HTML controls the appearance of text on the Web. Notice that the HTML
tags always appear <inside> brackets.

HTML Tag Formats

There are two HTML tag formats: paired tags and single tags. Paired tags
come in pairs that consist of a start tag and a stop tag. Headings are an ex-
ample of paired tags. For example, to make the words Internet Technol-
ogies At Work appear in the largest style of heading, you would mark them
up as follows:

L 6-1 <h1>Internet Technologies At Work</h1>

<h1> is the start tag, and </h1> is the stop tag. The words between
them will appear in heading style h1, which is the largest of the six heading
styles. You can tell a start tag from a stop tag because the stop tag always
has a slash, as in </h1>.

Single tags function on their own with no stop tag. For example, the tag
<hr> makes a line known as a “horizontal rule” appear on your Web
page; there is no stop tag for a horizontal rule.
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FIGURE 6-1 This is how my home page appears on the Web.
Notice the different-sized heading, the

paragraphs, and the list of bulleted items. �

FIGURE 6-2 This is the HTML source code that creates my
home page. The codes in <brackets> are the

HTML tags that mark up the text. �
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Versions of HTML

HTML has progressed through several versions, each of which added new
functionality to what you can do on a Web page. When HTML was in-
vented, the Web was a text-only medium used to display simple text docu-
ments onscreen. To keep the markup simple enough for beginners to learn,
HTML did not require all the structural elements defined by its parent
language, which is the standard generalizable markup language (SGML).
According to SGML, for example, every begin tag needs some kind of logi-
cal ending. In early versions of HTML, however, several elements did not
have end tags. The list item tag <li>, for example, did not have a corre-
sponding end tag </li>. Moreover, SGML requires the order of the tags
to adhere to the document’s defined structure. If a bold italicized phrase
begins, for example, with <strong> <em>, it must end with </em>
</strong> and not</strong></em>. Early versions of HTML permit-
ted both kinds of endings, and to this day, the browsers permit them both.

Such loose encoding, however, does not lend itself to the kind of struc-
ture needed to transition the Web into an application model in which serv-
ers exchange data in a disciplined manner. Enter XML, which stands for
eXtensible Markup Language. True to its name, XML enables you to ex-
tend a document’s structure by defining new tags. This was not possible in
HTML. Another difference between XML and HTML is that XML ad-
heres to the structural rules of SGML. Every begin tag must have an end-
ing, and the order in which the tags close must follow the structure of the
document’s definition.

More than a billion Web pages were created with HTML. The vast ma-
jority of these pages contain loose encodings that do not follow the strict
rules of SGML. As a result, these pages will not validate in XML tools that
require tags to follow the document’s definition. To solve this problem, the
W3C created a new language called XHTML. True to its name, XHTML
includes most of the classic HTML codes, but they appear in the context of
an XML schema (hence the X) that XML tools can understand.

Pages authored in XHTML will render not only on the Web but also on
pagers, PDAs, cell phones, tablet PCs, and other devices that are following
the new XML-based wireless protocols. XHTML pages can also be mined
by XML tools as data that can be used in server-to-server and business-to-
business applications. XHTML further enables you to use the extensible
style language (XSL) to transform a document from one format into an-
other, such as from an HTML Web page into a PDF document. Finally,
XHTML makes it possible for you to use other XML languages on your
Web page, such as the Synchronized Multimedia Integration Language
(SMIL), which you will play with in the XML section of Chapter 8.

In this book, the HTML tags you will be learning follow the XHTML
specification. To visit the official Web site where the HTML and XHTML
specifications are found, go to www.w3.org/MarkUp.



Taxonomy of HTML Tags

There are more than a hundred HTML tags. Learning that many tags may
seem like a foreboding task. You can simplify the process, however, if you
think of the tags as families devoted to accomplishing similar tasks. The
following taxonomy groups the HTML tags into 13 families:

� Page structure tags provide a framework for the document as a
whole. They identify that the document is encoded in HTML and
provide titling, framing, and header information that defines the
structure of the file.

� Block-style tags control the flow of text into blocks on the screen.
The most common block style is the paragraph.

� Logical font-style tags include styles for abbreviations, acronyms,
citations, and quotations.

� Physical font-style tags let you create text that is blinking, bold,
italic, subscripted, superscripted, or underlined.

� Heading tags let you create headings in six different levels or sizes
of importance.

� Lists and miscellaneous tags let you create numbered lists, bulleted
lists, menus, directories, horizontal dividing lines, and line breaks.

� Form tags let you create input fields, buttons, and selection boxes
for gathering information from users.

� Table tags let you define tables that present data in neat rows and
columns.

� Character entities provide a wide range of Greek characters and
special symbols used in mathematical and scientific notation.

� Anchor/link tags let you create bookmarks, hypertext, and
hyperpictures and link them to any resource or file on the World
Wide Web.

� Image tags let you insert figures, center or align pictures with the
left or right margin, flow text around images, or place little icons
inline in the midst of your text.

� Object tags provide a means for defining a way to interact with
plug-ins, media handlers, and Java applets, which are little
applications that get downloaded to your computer along with
a Web page.

Tags Used in the Web Page Creation Tutorial

Table 6-1 defines the HTML tags you will use in this chapter to create your
Web page résumé. These tags are all a standard part of HTML and
XHTML, and they work with almost any Web browser, including both
Netscape Navigator and the Microsoft Internet Explorer.
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Creating Your Web Page Résumé

Now that you know how HTML works, you are ready to apply your new
knowledge. The rest of this chapter takes you through all the steps needed
to build your own online résumé with text, graphics, and links to other
Web pages.

Starting the Page

To start a new Web page, follow these steps:

1. Get the Notepad running on your computer by double-clicking its
Launch icon. If this icon is not visible, use the Windows Start |
Programs | Accessories menu or the Macintosh Finder to locate
the Notepad program. If you have decided to use another program
instead of the Notepad to edit your HTML files, launch that other
program and use it whenever these instructions tell you to use the
Notepad.
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HTML Tag Syntax Use on Web Page

<html> and </html> These tags define the beginning and end of an HTML document. Your Web pages will always begin
with the <html> start tag and end with the </html> stop tag.

<head> and </head> The headers of your HTML file will appear between these tags.

<title> and </title> The title of your HTML file goes between these tags, which in turn go between the header tags.

<body> and </body> The body of your HTML file goes between these tags.

<h1> and </h1> You will use the h1 heading tags at the beginning of your résumé to make your name appear in the
most important heading style.

<p> and </p> The <p> tag marks the beginning of a new paragraph. The stop tag </p> is optional in HTML but
required in strict XHTML. The <p> tag always begins a new paragraph, whether or not a </p> tag
marks the end of the paragraph.

<ul> and </ul> These unordered list tags will mark the beginning and end of the table of contents in your résumé.

<li> and </li> The list item tag will mark each item in your table of contents.

<hr> The horizontal rule tag makes the neat three-dimensional dividing lines on Web pages.

<a name="name"> </a> A stands for anchor. An anchor tag with a name attribute creates names for the bookmarks in your
résumé.

<a href="url"> </a> Href stands for hypertext reference. An anchor tag with an href attribute creates hypertext links.

<img src="filename"> The image tag places pictures on your Web page.

<body background=
"filename"> </body>

The background attribute of the body tag tiles an image into the background of your Web page if
you want to give your résumé a textured appearance.

<table> and </table> Table cells go between these tags.

<tr> and </tr> You use these to create a row in a table; tr stands for table row.

<td> and </td> You use these to create a data cell inside a row of a table; td stands for table data.

TABLE 6-1 HTML Tags Used in the Web Page Creation Tutorial �



2. Click to position your cursor in the Notepad
window, and type the code illustrated in
Figure 6-3. This is the minimal amount of
HTML code needed to create a Web page.
Notice that this code creates a head section
and a body section. The body of your page
will go between the <body> and </body>
tags. The <head> will contain your page
title, which you create in the next section
of this chapter.

Creating the Page Title

The page title is the name that appears in the
browser’s title bar when people visit your Web page on the Internet. The
title is also used by many Web search engines, so you want to make sure
the title identifies the primary purpose of your Web page by including
keywords you want search engines to find. To create the page title, follow
these steps:

1. The page title goes in the head of the document, which is the
section of the Notepad file that goes between the <head> and
</head> tags. Therefore, click to position your cursor between
the document’s <head> and </head> tags.

2. Type the following code, replacing “Santa” with your own name:

<title>Santa's Resume</title>

Figure 6-4 shows how your HTML appears after you create the docu-
ment’s title. Notice that the title of the document gets typed between the
<title> start tag and the </title> stop tag. At runtime out on the
Web, this title will appear in your browser’s title bar.

Writing the Heading

Because this Web page is your résumé, you want to start it with a heading
that includes your name in big, bold letters at the top of the Web page.
The largest heading style is the <h1> style. To create a heading, follow
these steps:

1. Click to position your cursor in the body of the document, which
is the section of the page that comes after the <body> start tag
but before the </body> stop tag.

2. Type the following code, replacing “Santa Claus” with your
own name:

<h1>Santa Claus's Resume</h1>

Figure 6-5 shows how your code will appear. In the next part of this tu-
torial, you save this page and then preview it by opening it with your
browser. Read on.
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FIGURE 6-3 This is the minimal amount of HTML code needed to
create a Web page. The body of your page will go between the <body>
and the </body> tags. The <head> will contain your page title, which you
create in the next section of this chapter. �

The tags <html> and </html>
mark the beginning and end of an
HTML document.

The document’s head will go
between the <head> and
</head> tags.

The document’s body will go
between the <body> and
</body> tags.

FIGURE 6-4 You type the document’s
title tags between the <head> and </head>
tags, which demarcate the head section of
the Web page. When someone views the
page out on the Web, this title will appear
in the browser’s title bar. �

Insert the title tags between the
<head> and </head> tags.

FIGURE 6-5 You type the <h1> tag
into the document’s body, which is where you
will type all of your résumé’s content. The <h1>
tag will cause the text between it and the </h1>
stop tag to appear in heading style 1, which is
a very large font. In the next part of this tutorial,
you learn how to save and preview what this
page will look like out on the Web. �

Insert your résumé’s content between
the <body> and </body> tags.



Saving the Page

Whenever you make a change to a file you want to keep, you should save
the file. Do so now by following these steps:

1. Pull down the File menu and choose Save. The first time you save
a file, the Save As dialog appears, as illustrated in Figure 6-6.

2. If the folder in which you want to save the file does not already
exist, you can use the Save As dialog’s icons to create a file folder.
In this example, click the Up One Level icon to move up a level
until you get to the root of your drive; then click the Create New
Folder icon to create a new folder. Name the new folder website
and then double-click that folder’s icon to enter it.

3. In the File name field, type the name you want the file to have.
In this example, type resume.html.

4. Pull down the Save as Type menu, and set it to All Files.

5. Click the Save button to save the file. From now on, to save this
file after you make changes, all you need to do is pull down the
File menu and click Save. If you ever want to save it under a
different name, pull down the File menu and click Save As.
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FIGURE 6-6 The Save As dialog appears the first time you save a newly
created file. Use the controls to select or create the file folder

into which you want to save your file. In this example, use the Up One Level button to
navigate to the root of your drive; then use the Create New Folder button to create a
new folder called website. Double-click to enter that folder, and save the file under the
name resume.html. �

Click the Up One Level
button a time or two until
you get to the root of your
drive.

Click the Create New
Folder button to create a
new folder, name it
website; then double-click
the new folder to enter it.

Type the filename here.

Set the type to All Files;
otherwise the Notepad
will save the file with a
.txt filename extension.



Viewing the Page with a Web Browser

While you are creating a new Web page, you will want to have a look at
it with a Web browser from time to time so you can see how it is going to
appear on the Web. To preview a Web page with a browser, follow
these steps:

1. Pull down the browser’s File menu and choose Open to make the
Open dialog appear.

2. Click the Browse button and use the controls to select the file you
want to view. In this example, assuming your hard drive is letter
C, select your file named c:\website\resume.html.

3. Click OK to open the file, which now appears in your browser, as
illustrated in Figure 6-7.

4. When you finish viewing the file, you can save time by avoiding
the temptation to close the browser window. Instead of closing
the browser, hold down the ALT key and click TAB until you get
back to your Notepad, where you can continue editing the file.
Whenever you want to preview the file, use the Notepad to save
it. Then ALT-TAB back to your browser and click the browser’s
Refresh button to read the new version of the file.

Writing Paragraphs

Now you are ready to type the first paragraph of your résumé. Move your
cursor to the spot in the Notepad right after the heading’s </h1> stop tag,
and press ENTER. If you mistakenly press ENTER in the midst of the head-
ing instead of at the end of it, you can pull down the Edit menu and choose
Undo to fix the mistake.
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FIGURE 6-7 You can save valuable time by keeping the Notepad and the browser open simultaneously
when you are using them to edit and preview a Web page. Whenever you make

a change in the Notepad that you want to view with the browser, save the file in the Notepad, and then
ALT-TAB to the browser and click the browser’s Refresh button to view the new version of the file. Then you
can ALT-TAB back to the Notepad to continue editing the Web page. �

Click the Refresh button to view the new
version of the file; ALT-TAB back
to the Notepad to continue
editing the Web page.

Use the File menu to save the change you want to preview;
then ALT-TAB to the browser.



To begin the new paragraph, type the <p> tag followed by a few sen-
tences about yourself as an introduction to your résumé. Do not be bash-
ful: a résumé should begin with a strongly stated summary of your
professional qualifications and career goals. At the end of each paragraph,
you should type the </p> stop tag, although the browsers may let you get
away without it. Figure 6-8 shows how I began my résumé.

After you type your opening paragraphs, use the Notepad’s File menu to
save the page, and then use your browser to preview it. Remember that
you can save time if you keep the Notepad and browser windows open and
ALT-TAB between them while editing and previewing your page. Click the
browser’s Refresh button to view the new version of the page. Notice that
the paragraphs you typed appear beneath the heading of your résumé.

Creating a List

You create lists with the unordered list<ul> start and</ul> stop tags for
a bulleted list, or the ordered list <ol> start and </ol> stop tags for a
numbered list. In between these tags, you type the list items, which must
begin and end with the list item <li> start and </li> stop tags.

Now that you have created the two introductory paragraphs of your
résumé, it is time to create the bulleted list that will serve as your table of
contents. Follow these steps:

1. Position your cursor in the Notepad window just after the </p>
stop tag at the end of your second paragraph, and press ENTER to
move down to the next line.

2. Type the <ul> tag and press ENTER. The <ul> tag begins an
unordered list.

3. Type the </ul> tag and press ENTER. The </ul> tag ends an
unordered list. You may justifiably ask, why type the end-of-list
tag before typing the list itself? The reason is to keep from forgetting
to do so. Of course, the page will work regardless of whether you
type the </ul> tag before or after typing the list.
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FIGURE 6-8 How I typed the first two paragraphs of my résumé. Do not be
bashful about promoting yourself. A résumé must impress potential

employers that you are a desirable job candidate. �

Each paragraph begins with a <p> start tag.

Each paragraph ends
with a </p> stop tag.

The character code &eacute; creates an é when displayed by a browser.



4. Position your cursor between the <ul> and </ul> tags, which is
where the list items will go.

5. For each item, type the <li> start tag to begin the list item,
followed by the item itself, followed by the </li> stop tag to
end the item. Figure 6-9 shows how I typed my list items into
the Notepad, and Figure 6-10 shows the resulting Web page.

Horizontal Rules

A horizontal rule is a Web page element that creates a neat-looking divid-
ing line between different parts of a Web page. To insert a horizontal rule
after the bulleted table of contents in your résumé, follow these steps:

1. In the Notepad window, position your cursor after the </ul> stop
tag at the end of the list. Press ENTER to move down to a new line.

2. Type the HTML tag for a horizontal rule, which is <hr>.

3. Save the file in the Notepad, and preview the new version of the
file in the browser. Remember to click the browser’s Refresh button
to make sure you are viewing the newly saved version of the file.

Inserting horizontal rules in your documents is easy, and the dividing
lines look nice. However, do not give in to the temptation to overuse them!
Horizontal rules are best used to separate major sections of your document.

Remember to Save the File

Remember to save your HTML file periodically to prevent accidental data
loss due to power failures or other accidents. To save the file, pull down the
Notepad’s File menu and choose Save. In addition to saving the file on
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FIGURE 6-9 My bulleted list consists of ten
list items. Notice that the list

is bounded by the <ul> start and </ul> stop tags.
Similarly, each list item is demarcated by the <li>
start and </li> stop tags. �

FIGURE 6-10 This is a browser preview of the HTML in Figure 6-9.
Notice that the browser displays the unordered list with

bullets. If the list were ordered, on the other hand, the browser would have used
numbers instead of bullets. Chapter 8 shows you how to use a style sheet to change
the default appearance of bullets, numbers, and other elements onscreen. �



your primary drive, it is also a good idea to make a copy of the file on an-
other storage device from time to time. Such a spare copy is known as a
backup. Having a backup will protect you from data loss in case of a
power failure or a hard disk crash on your primary working drive. The
backup also provides you with a way to retrieve your good work in case
you make a mistake and really mess something up on your primary copy.

The importance of backing up your files cannot be overemphasized.
Floppy disks, CD-R disks, and zip drives provide you with economical
ways to back up your files. Keeping a copy of your backups in more than
one physical location can help protect against data loss in case of a fire or
some other kind of unforeseen calamity. I hope such a tragedy will never
happen to you. According to Murphy’s Law, if you faithfully keep a
backup, you will never need it. In other words, always make a backup!

Inserting a New Heading

Every main section of your résumé should begin with a large-sized heading
that identifies what that section is. It is common for Web pages to have a ti-
tle displayed in the largest-sized heading, <h1>, and then to use the next
smaller size, <h2>, for subheads. For example, when you enter the educa-
tional qualifications section of your résumé, follow these steps to give it a
heading:

1. In the Notepad, position your cursor at the start of the education
section of your résumé. This location will probably be right after
the horizontal line you just inserted.

2. Press ENTER to move down to a new line.

3. Type the heading, which in this example will be Educational
Qualifications. To make this have the heading 2 style, the tag
to type is:

<h2>Educational Qualifications</h2>

4. To begin a new paragraph after the heading, position your cursor
at the end of the heading, press ENTER to move down to the next
line, type the <p> tag to start a new paragraph, and type the
content of the next section. Remember to end each paragraph
with the </p> stop tag.

Creating Named Anchor Bookmarks

As you create the different sections in your résumé, it will grow too long
for the browser to display it onscreen all at once. So users can easily find
the parts of your résumé, you can insert bookmarks known as named an-
chors into your document. Then you can link each item in your résumé’s
bulleted list of topics to its corresponding bookmark to make it quick and
easy for the user to find that section. To create a named anchor bookmark,
follow these steps:
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1. Click to position your cursor at the spot in the Notepad window
where you want the bookmark to be. In this example, position
your cursor at the start of the Education section, right before the
<h2> tag that demarcates that section’s heading.

2. You use the anchor tag to create a name for a bookmark. To make
a bookmark named “education,” type the following anchor tag:

<a name="education"></a>

Figure 6-11 shows an example of how I
completed this exercise. Now that the
bookmark’s name has been created, you
must next create the link that will take users
from the corresponding item in the table of
contents to your education section. The
next section of this tutorial shows you how
to do this. Read on.

Creating Hypertext Links to
Named Anchor Bookmarks

Think about the items in your bulleted ta-
ble of contents. You want each item to serve
as a hypertext link that, when clicked, will
jump the page down to the bookmarked
name of its corresponding anchor. The ta-
ble of contents item “Educational Qualifi-
cations,” for example, needs to become a
link that, when clicked, takes users to the education bookmark in your
résumé. To create such a link, follow these steps:

1. In the Notepad, click to position your cursor immediately before
the word Educational in the unordered list that serves as your
table of contents. Make sure the cursor is after the <li> tag and
before the word Educational.

2. You create a hypertext link with an anchor tag. To begin such a
tag, type the following code:

<a href="#education">

3. In this tag, href is an attribute that stands for hypertext reference.
The word in quotes is the value of this attribute, which is set to
#education to make the link point to the bookmark named
education. The pound sign character # tells the browser that the
target of the link is a named anchor bookmark on the same page.

4. Remember that every anchor tag must have a </a> stop tag.
Therefore, click to position your cursor after the phrase Educational
Qualifications and type the </a> tag. Figure 6-12 shows the
completed Notepad file.
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FIGURE 6-11 To create a name for a bookmark, you use the anchor tag.
In this example, an anchor tag named “education” will

serve as a bookmark enabling users to jump to the education section of your
résumé. Thus, a named anchor is a bookmark to which you can create links that,
when clicked, take users to that spot on the page. In the next section of this
tutorial, you create the link that the users will click �

This is the horizontal rule
at the end of the bulleted

table of contents.

Name is an attribute
of the anchor tag.

Every <a> start tag must be
followed by a </a> stop tag.

This is the heading that
begins the education section.



5. Save the file and preview it with your Web browser. The words
Educational Qualifications should appear in color in your
résumé’s bulleted table of contents. The coloration denotes
hypertext; clicking the colored text will trigger the link.

6. Go ahead and click the link to see how it works. If your browser
jumps to the Educational Qualifications section of your résumé,
congratulate yourself! If not, repeat these steps, compare your
HTML to the samples shown here, and keep trying until you get
the bookmark link to work.

Returning to the Table of Contents

Web pages that use named anchor bookmarks should provide a way to re-
turn to the table of contents so the user can make another selection. Cre-
ating such a return-to-contents link is a two-step process. First, you create
a named anchor bookmark at the start of the bulleted list to which you
want users to return; then you create a return link to that bookmark at the
end of each section in your document.

To create a return-to-contents link in the Education section of your
résumé, follow these steps:

1. Click to position your cursor at the spot in the Notepad window
where your table of contents begins. In this example, position
your cursor in front of the <ul> tag that signals the beginning of
your bulleted list.

2. Create a named anchor bookmark called contents—try to do this
on your own, but if you need help, type the following command:

<a name="contents"></a>

3. Position your cursor at the end of the Educational Qualifications
section of your résumé. Insert a new paragraph that contains the
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FIGURE 6-12 You create a hypertext link via the hypertext reference (href) attribute of an
anchor tag. In this example, the href is #education,which links the text to the

education bookmark further down on the page. After the hot words you are linking, remember that
you must type the </a> close tag so the browser will know where the anchor ends. �

The words between the
<a> start and </a>
stop tags are the hot
words.

Every <a> start tag
must be followed by
an </a> stop tag.

The hypertext reference
(href) attribute tells

where the link will go
when clicked.

When a user clicks the
#education href,

the browser will jump here.

note If your browser window is
large enough to display the entire page,
you may not see the browser jump
when you click the link. Resize the
window to make it small, and then you
will see the browser jump when you
click the link.



text Table of Contents, and link that text to the contents bookmark.
Try to do this on your own, but if you need help, here is the code
to type:

<a href="#contents">Return to Contents</a>

4. Save the file and preview it with your Web browser. Click your
browser’s Refresh button to make sure you are viewing the latest
version of the page. Scroll down to the bottom of your educational
qualifications, and click the link to return to contents. If your
browser jumps back up to your résumé’s table of contents,
congratulate yourself! If not, keep trying until you get the
bookmark link to work.

Linking to URLs

There are more than a billion documents on the World Wide Web. You can
link your résumé to any document for which you know the URL. For exam-
ple, if the place where you work or go to school has a home page, you might
want to provide a way for users to navigate there. Follow these steps:

1. In your Notepad window, position your cursor at the spot where
you want the link to appear, and type the text that will trigger the
link. For example, type the text:

University of Delaware

2. Surround the text you just typed by the anchor start and stop tags;
the example now reads:

<a>University of Delaware</a>

3. Add to the start tag an href attribute that tells the browser where
to go when users click the link. The completed example is:

<a href="http://www.udel.edu">University of Delaware</a>

4. Save the file and preview it with your Web browser. Click your
browser’s Refresh button to make sure you are viewing the latest
version of the page. Click the link you created in the previous
step. If it works, congratulate yourself. If the link does not work,
troubleshoot the problem until you get it working. Make sure you
are spelling your href correctly, and compare your code to the
University of Delaware example in the previous step.

Identifying the Web Page Owner

Netiquette calls for Web pages to end with a few lines of text indicating
who owns the page and how to contact the owner. To identify yourself as
the owner of your Web page, follow these steps:

1. Click to position the cursor in your Notepad window at the
bottom of the document.

2. Type the paragraph <p> start and </p> stop tags to create a new
paragraph.
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note If you really get stuck,
remember that you can go to my
résumé at www.udel.edu/fth/
resume.html, pull down the View menu,
and choose Source to see how I coded
my return-to-contents link.



3. Between the paragraph start and stop tags, type the following
words, replacing Santa’s information with your own:
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warning Beware that spammers
can harvest e-mail addresses from Web
pages that contain mailto links. You need
to consider this risk in deciding whether
to put a mailto link on your page.

<p>

This Web page is owned by Santa Claus. My e-mail address is santa@northpole.com.

</p>

Mailto Links

A mailto is a link that, when clicked, opens a new message window ad-
dressed to the person identified in the link. It is customary for Web page
owners to include a mailto link to their e-mail address to make it easy for
users to contact them. Consider the Web page owner statement, for exam-
ple, that you put at the bottom of your home page. Your e-mail address ap-
pears there. To provide a mailto link to your e-mail address, you would
modify the last sentence to read as follows:

L 6-2 My e-mail address is <a href="mailto:santa@northpole.com">santa@northpole.com</a>.

Creating White Space on Web Pages

By now you have probably noticed that white space does not work the
same way in the browser as it does in the Notepad. If you press ENTER a
few times to create some white space in your Notepad, for example, and
then save the file and view it with your browser, you will notice that the
browser ignores those line feeds. Similarly, if you type several spaces in a
row to create a blank space in the Notepad, and then save the file and view
it with your browser, you will observe that the browser prints only one of
the spaces and ignores the others.

The browser ignores line feeds and multiple spaces because of the struc-
tural rules of HTML. When you want to create white space onscreen, you
need to use the appropriate HTML code to do so. You have already mas-
tered the most commonly used white space codes, which are the paragraph
<p> start and </p> stop tags. Another handy white-space code is the
<br> break tag, which makes the browser go down to the next line of the
screen. There is also a code for a single white space character called a non-
breaking space. The code for this character is&nbsp; (including the semi-
colon, which signals the end of the special code). When the browser en-
counters the code &nbsp; it prints a single white space onscreen. You
could therefore type &nbsp;&nbsp;&nbsp;&nbsp;&nbsp; into the
Notepad file to make the browser display five consecutive white spaces
onscreen.

Character Attributes on Web Pages vs. Word Processors

Because word processors are habit-forming, no chapter on Web page cre-
ation would be complete without mentioning some caveats regarding
things you commonly do with a word processor but should not do when
you are editing a Web page.
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Underlining

In a word-processed document, it is common to underline things for em-
phasis. On the Web, underlining normally means that the underlined text
is linked as hypertext. If you want to emphasize something on the Web,
therefore, use bolding or italics instead of underlining. To bold something
you are editing with your Notepad, surround it by the <strong> start
and </strong> stop tags. To italicize something, enclose it within the
emphasis <em> start and </em> stop tags. You can further stylize the text
with style sheets, which you study in Chapter 8.

Avoiding the Pagination Temptation

In a word processor, you can press ENTER repeatedly to add white space to
arrange the text to fit the size of the printed page. A common mistake be-
ginners make is to try to do the same thing on a Web page. It does not
work, because there is no guarantee that the viewer’s screen size or win-
dow size will fit the one for which you developed your page.

Resist the temptation to press the ENTER key repeatedly to add white
space in an attempt to create pagination on a Web page. If you want a new
page, create a new Web page and link to it from a hypertext link or a navi-
gational icon. You learn how to link pages later, in the hypermedia design
section of this chapter. If you want to control spacing on the screen, the
best way to do that is with a table. You learn how to make tables in the lay-
out section of this chapter.

HTML Graphics and Animated GIFs

It has often been said that a picture is worth a thousand words. The ease
with which you can insert pictures into Web pages means you can illustrate
documents and use images as design elements in the layout of a Web page.
Before you can insert a picture into a Web page, however, you must get the
picture into the proper format for display on a Web page. This chapter
provides you with a utility that makes it easy to get images into the proper
format. Then it shows you not only how to insert pictures into Web pages
but also how to create special effects with techniques known as tiling and
watermarking.

Obtaining Images to Use on a Web Page

Assume you have an image you want to insert into your Web page. Because
you have created a Web page résumé, it would be natural to include your pic-
ture in the upper-left corner of the résumé so prospective employers can see
what you look like. Many photo shops, such as Kodak, and mass-market
retail stores, such as Eckerd Drugs, give you the option of having a floppy
disk or a CD returned along with your prints when you have a roll of film
developed. Eckerd Drugs, for example, charges $6 extra to get a Kodak
Picture CD containing a JPEG digital image of each picture on the film. In
partnership with Kodak, Eckerd also provides an online service called

note Previous versions of HTML
used <b> and </b> tags to bold text,
and <i> and </i> tags to italicize.
The latest version of HTML deprecated
these tags, replacing them by
<strong> </strong> for bolding,
and <em> </em> for italics. In strict
XHTML, you create these kinds of
effects with style sheets, which you study
in Chapter 8.
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Kodak PhotoNet Online. When your film is developed, you can view your
photos on the Web and order high-resolution copies of the images you
want. For professional-quality imaging, you can order a Kodak Photo CD
when you send in your film to be developed. The Photo CD contains five or
six versions of each picture, sampled at resolutions ranging from a wallet-
sized thumbnail to a poster version much larger than the size of your com-
puter screen. For more information, follow this book’s Web site links to
Eckerd Drugs and Kodak Photo CD.

If you own a digital camera, you do not need to have your pictures de-
veloped: Digital cameras take pictures as bitmaps, which can be down-
loaded from the camera to your PC. Epson, Canon, Kodak, and Olympus
are just a few of the companies that make digital cameras. To find out what
digital cameras are available and how their features compare, follow this
book’s Web site links to Digital Cameras.

Scanners have dropped in price so much that they have become mass-
market consumer items. Sometimes you get a scanner for free when you
purchase a new multimedia PC. Scanners come with software that can dig-
itize printed photographs you can put on Web pages.

On the other hand, if you prefer not to include your picture on your
résumé, you may want to enhance the résumé’s appearance by including
some other graphics. There is a Web page full of general-purpose graphics
at this book’s Web site. You can download any image on this page by right-
clicking the image to pop out the quick menu; then choose Save As to save
the image file on your hard drive. To inspect these images, follow the links
to general-purpose graphics at this book’s Web site.

Preparing Images for a Web Page

Before you can insert an image into a Web page, you need to ask yourself
the following questions:

� Is the image in the correct format for inserting onto a Web page?
Images must be in either the GIF or JPEG file format. If the image
is not in the correct format, you must convert it into the proper
file format:

■ Use the GIF format if the image has 256 colors or fewer, or
if you can live with reducing the color depth of a more fully
colored image to 256 colors.

■ Use the JPEG file format if your image has more than
256 colors and you need true color.

■ Use the GIF format if you need one of the colors in the
image to be transparent. On Web pages, for example, you
will sometimes want the background of the image to be
transparent so it can overlay or float on the page.

� Is the image the proper size for your Web page layout? Images that
are too large need to be reduced in size with a graphics editor.
Many people think they can skip this step and just resize the image
with their Web editing software. This does not change the size of
the file, however, and the quality will not be as good as when you



resize an image with a graphics editor. That is because the browser
is told to show the still-large file at a smaller size, but the browser
is not as good at resizing images as the graphics editor. If you need
to resize an image, therefore, you should do it with a graphics
editor. As an added bonus, the smaller file size will save on
bandwidth and make the page appear sooner.

� What is the color format of the image? If the image is in 24-bit
format (16 million colors), you may want to reduce it to an 8-bit
color format (256 colors), which will greatly reduce its file size.
Remember that the larger the file size of the image, the longer it
will take to download from the Internet.

Happily, there are graphics programs that enable you to do all of these
things. In the next section of this chapter, you learn how to use Paint Shop
Pro for Windows to prepare images to put on your Web pages.

Configuring Paint Shop Pro

Paint Shop Pro is a Windows program for image capture, creation, view-
ing, and manipulation. Features include painting, photo retouching, im-
age enhancement and editing, color enhancement, graphics format
conversion, and color scanner support. More than 30 image file formats
are supported, including GIF, JPEG, TIFF, Kodak Photo CD, BMP, and
PNG. You can even browse images on your computer; Figure 6-13 shows
how the images appear as thumbnails, which you can double-click to view
full-screen.
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FIGURE 6-13 Paint Shop Pro contains an image browser and many powerful graphics tools. Shown here is
the browser, which comes in handy when you are looking for an image. You can double-click

an image to bring it up in the Paint Shop Pro editor, or right-click it for a variety of image management functions. �

Moving your cursor
over an image reveals
its properties.
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You can try an evaluation version of Paint Shop Pro before you buy. You
can download it from the Web by following this book’s Web site links to
Paint Shop Pro. If you want to use the software after 60 days, you must pay
the license fee, or the evaluation copy will expire.

The first time you run Paint Shop Pro, you must set up the hot key you
will use to capture graphics. Follow these steps:

1. Double-click the Paint Shop Pro icon to get Paint Shop
Pro running.

2. Pull down the File menu and choose Import | Screen
Capture | Setup. The Capture Setup dialog appears as
shown in Figure 6-14.

3. Notice that the Capture group lets you set up to capture
an area, the full screen, the client area of the current
window, the entire current window, or an object. Set it
to capture an area.

4. In the Activate Capture group, click the option to activate
via Hot Key, and set the hot key to something you never
use in any other application; I recommend you set the hot
key to SHIFT-F11, which is the hot key this tutorial uses.

5. Click OK to close the dialog.

Capturing Images

A basic skill important to all Web page developers is the ability to capture
an image, or part of an image, and save it on the hard drive. You have al-
ready learned that if the graphic is on a Web page, and if you are capturing
the entire graphic, you can right-click the graphic and choose Save As to
download it onto your hard drive. Sometimes, however, the right-click
does not work. You may want to capture only part of the image, for exam-
ple, or the image might be in an application that does not support the right-
click method of copying. When the right-click method does not work or
will not do what you want, follow these steps to capture the image:

1. Get the program running from which you want to capture a
graphic. For example, suppose you want to capture my smiling
face. Get your Web browser running, and go to http://
www.udel.edu/fth where my photo appears on my Web page.

2. Get Paint Shop Pro running, if it is not running already.

3. Hold down the ALT key and keep pressing TAB until Paint Shop
Pro appears. ALT-TAB is a special Windows key for switching
among programs running simultaneously on your computer.

4. Click the Paint Shop Pro Start Capture button, or press SHIFT-C,
or pull down Paint Shop Pro’s File menu and select Import |
Screen Capture | Start. Immediately, Paint Shop Pro disappears.

5. If the image you want to capture is not visible on your screen,
hold down ALT and keep pressing TAB until the screen you want
to capture appears.

FIGURE 6-14 The Paint Shop Pro Capture Setup
dialog. This book recommends setting

up the capture key to be SHIFT-F11 because it is my experience
that SHIFT-F11 is most compatible with the mainstream of
Windows programs. Other key combinations can conflict
with hot keys predefined in these programs. �



6. Press the capture hot key (SHIFT-F11); the cursor turns into a
crosshair.

7. Click the upper-left corner of the area of the screen you want to
capture, and then click the lower-right corner to complete the
capture. In this example, you first want to click the upper-left
corner of my smiling face and then click the lower-right corner.

8. The captured image should now appear in the Paint Shop Pro
window. To save the image, pull down the File menu and choose
Save As.

9. In the Save as Type box, select the image format in which you
want to save the image. In this example, select CompuServe
Graphics Interchange (GIF).

10. In the File Name field, type the name you want the image to have.
In this example, type fred. You do not need to type a filename
extension, because Paint Shop Pro will supply one automatically,
based on the file type you set in the Save as Type box.

11. Click the Save button to save the file; then pull down the File
menu and choose Exit to leave Paint Shop Pro.

Converting Images

Converting images into the proper format for inserting onto Web pages is
easy. As noted earlier, the best formats to use are GIF if the image has 256
colors or fewer or JPG if your image has up to 16 million colors. To convert
an image from one file format into another, follow these steps:

1. Pull down the Paint Shop Pro File menu and
choose Open; the Open dialog appears.

2. In the List Files of Type field, pull down the
choices and select the file format of your
original image.

3. Browse to the image and click OK to open it;
the image appears onscreen.

4. To convert the image, pull down the File menu
and choose Save As; the Save As dialog
appears, as shown in Figure 6-15.

5. In the Save as Type field, pull down the
choices and select either GIF or JPG.

6. Save the file in the folder of your choice
(probably your website folder).

7. Make sure the name you give the image has
the same filename extension as the file format
you selected (GIF or JPG).
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note To capture the full screen
or the contents of a window, pull down
the File menu, choose Import | Screen
Capture | Setup, and set the Capture
option accordingly.

FIGURE 6-15 The Paint Shop Pro Save As dialog. When
you save the image, make sure the name you

give it has the same filename extension as the file format you selected
(GIF or JPG). �

Set the file format here.



When you save the file, it is important to save it in the same folder as the
Web page for which it is intended. In this case, if you are making an image
for your Web page résumé, save the converted image in your website
folder. This will simplify the publication process when you transfer your
files to the Web in Chapter 7.

Resizing Images

Images may be the wrong size for placement on your Web page. For exam-
ple, the photo that appears on my Web page résumé was a 640 x 480 im-
age. This would have covered way too much screen space, spoiling the
layout of the résumé. Although you can make the image appear smaller by
dragging its handles in a WYSIWYG Web page editor, this does not reduce
the file size of the image and therefore consumes more bandwidth than a
truly resized image. To truly resize an image, follow these steps:

1. Pull down the Paint Shop Pro File menu and choose Open; the
Open dialog appears.

2. In the List Files of Type field, pull down the choices and select the
file format of your original image.

3. Browse to the image and click OK to open it. The image appears
onscreen.

4. To resize the image, pull down the Image menu and choose Resize;
the Resize dialog appears, as shown in Figure 6-16.

5. Click a size option, such as Percentage of Original, and then make
the numbers larger or smaller, depending on whether you want the
image to be larger or smaller. Check the Maintain Aspect Ratio
box if you want the resized image to have the same proportions as
the original.

6. Click OK; the resized image appears.

7. Pull down the File menu, and either choose Save to save this file
under the same name as the original (this will replace the original
file) or choose Save As to save it under another name.

Make sure you save the resized file in the GIF or JPEG file format in the
same folder as the Web page on which it will appear. If you are resizing an
image for your Web page résumé, save the image in your website folder.

Color Adjustments

Unless you have a special reason for keeping your images encoded in 16
million colors (24-bit format), you should convert the images to 256 col-
ors (8-bit format), which will make them appear three times faster on your
Web page due to the smaller file size. To convert a 24-bit image into an 8-
bit image, follow these steps:
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FIGURE 6-16 The Resize dialog in
Paint Shop Pro. When you resize an image, you
will normally want to maintain the same aspect
ratio as the original to keep from distorting
the image as you resize it. �

Check this box if you want the resized
image to have the same proportions
as the original.



1. Pull down the Paint Shop Pro File menu, choose Open, and open
the image, which appears onscreen.

2. Pull down the Colors menu, choose Decrease Color Depth, and
see if the 256-colors option is active. If it is not active, your image
does not need to be reduced in color depth, so close the image and
skip the rest of these instructions.

3. If the 256-colors option is active, select it; the
Decrease Color Depth dialog appears, as shown
in Figure 6-17.

4. If you choose one of the Optimized palette
settings, click the option to Include Windows’
Colors. If you are planning to publish this image
to the Web, choose Standard/Web-safe.

5. Whether to choose Nearest Color or Error
Diffusion is up to you. Click OK to close the
dialog.

6. Pull down the File menu, and either choose Save
to save this file under the same name as the
original (this will replace the original file) or
choose Save As to save it under another name.

Make sure you save the color-converted file in the
GIF or JPEG file format in the same folder as the Web
page on which it will appear. If you are converting an
image for your Web page résumé, save the image in your
website folder.

Inserting an Image into Your Web Page Résumé

You will be happy to discover that inserting an image into a Web page is a
lot easier than preparing the picture to fit the Web page’s layout. To insert
an image into a Web page, follow these steps:

1. Open the page with the Notepad, and click to position your
cursor at the spot where you want the image to appear. In this
example, position your cursor after the </h1> tag that concludes
the heading of your résumé.

2. Type the following image tag, replacing the name of the image,
fred.gif, with the name of your own image:

<img src="fred.gif">

3. Save the file and preview it with your Web browser. Click your
browser’s Refresh button to make sure you are viewing the latest
version of the page.

4. To make the text wrap around the image, you can use the align
attribute. To position the image on the left side of the text, use the
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FIGURE 6-17 The Decrease Color Depth dialog in Paint
Shop Pro. Decreasing the color depth can

reduce the size of the file by a factor of two or three, thereby decreasing
download times and improving bandwidth. �



align=“left” setting; to position the image on the right side of the
text, use the align=“right” setting, as in:

<img src="fred.gif" align="right">

If you have trouble getting the image to position itself exactly where you
want it on your Web page, do not worry. In the next part of this chapter,
you learn how to use tables to control more precisely the layout and posi-
tioning of text and graphics on your Web pages.

Tiling an Image into the Background of a Web Page

As a final touch, you can consider adding some pizzazz to your résumé by
setting a background image that the browser uses as a tile in creating the
background. To tile an image means to draw it repeatedly across and
down the screen until the entire window has been covered. If the image is
designed in such a way as to hide the edges when tiled, you get a seamless
appearance in the background.

If you plan to display printed text on the tiled background, be sure to
choose a tile that will not interfere with the readability of your text. This
book’s Web site has a page that contains a few images designed for tiling on
Web pages. These tiles have slight coloration and faint textures upon
which you can place text that will be readable. The tiles at the Web site ap-
pear as follows:

brick.gif linoleum.gif wooden.gif woven.gif

To download one of these tiles to your computer, right-click its image
(Macintosh users use CONTROL-click), and choose Save As to download
the tile. Make sure you save the tile in your website folder. Then follow
these steps to make one of the tiles fill the background of your résumé:

1. Use your Notepad editor to open the page on which you want to
tile the background, and locate the <body> tag that begins the
body of the document.

2. Modify the <body> tag as follows, but replace filename by the
name of the tile you want to use:

<body background="filename.gif">

3. Save the file and preview it with your Web browser. Click your
browser’s Refresh button to make sure you are viewing the latest
version of the page.

Creating Transparent Images

Transparency is a special effect in which one of the colors in a bitmap be-
comes translucent. Instead of seeing that color, you see through it into
the background color or image on the screen. Consider the example in

Internet Technologies at Work

note If you did this correctly, you
now see the tiled background behind
the text of your Web page. As you can
see, the background attribute of
the body tag causes the image to tile
across and down the screen. If you do
not see the tiled background, however,
repeat these steps more carefully until
you get it working.



Figure 6-18, which shows two images overlaid on a background. In the
first image, there is no transparency, and the image looks rectangular. In
the second image, the red pixels are transparent, so you can see through
them into the background.

To create a transparent GIF image, follow these steps:

� Use Paint Shop Pro to open the image.

� Use the eyedropper tool to set the background color.

� Pull down the Colors menu and choose Set Palette Transparency.
Paint Shop may prompt you to reduce the color depth if the image
has more than 256 colors; click Yes to do so.

� When the Set Palette Transparency dialog appears, choose the
option to set the transparency value to the current background
color.

� Pull down the File menu and choose Save As to make the Save As
dialog appear. In the Save as Type field, pull down the choices and
select GIF. Save the file in the folder of your choice (probably your
website folder).

� To insert the image into your
Web page, insert into your
Notepad file an image tag in
the form of <img src=
"filename.gif">. When
you save the file and open it
with your browser, you will
notice that the transparent
color in the GIF image
becomes invisible.

Creating Animated Images

A special feature of the GIF graphics
format is its capability to contain an-
imated images. An animated GIF is a graphic that contains multiple im-
ages intended to be shown in a sequence at specific times and locations on
the screen. A looping option causes your Web browser to keep showing the
frames in the GIF file continually, and, as a result, you see an animation
onscreen.

GIF Construction Set

There is a shareware application that Windows users can utilize to create
animated GIFs. The name of the package is GIF Construction Set. To
download it and take a tutorial on creating animated GIFs, follow this
book’s Web site link to the GIF Construction Set.
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note You right-click with the
eyedropper to set the background color.
A left-click, on the other hand, sets the
foreground color.

FIGURE 6-18 Two images overlaid on a background: one with transparency, the other
without. When the solid red color is defined as the transparent color,

you see through it into the background onscreen. �



Animation Shop

You can also create animated GIFs with Animation Shop, which is part of
the Paint Shop Pro software. To run Animation Shop, pull down the Paint
Shop Pro File menu and choose Jasc Software Products | Launch Anima-
tion Shop.

Clip Art for Web Pages

Clip art is pre-drawn artwork organized into a catalog or library that you
can browse in search of appropriate icons, buttons, banners, back-
grounds, tiles, or animated GIFs for use on Web pages. Microsoft keeps an
extensive clip art gallery, for example, that you can search by genre, topic,
and keyword. Follow this book’s Web site links to the Microsoft Clip Gal-
lery and several other clip art libraries. Most of these libraries let you freely
download and use the graphics on your personal Web pages. Make sure
you check the clip art site’s license or copyright policy, however, especially
if you are planning to use the clip art in a product you will be offering for
sale. Clip art vendors often require you to pay a special fee for a license that
lets you use their clip art in a commercial product.

To download an item of clip art for use on a Web page, you can often
simply right-click (Macintosh users use CONTROL-click) the object, and
when the quick menu pops out, choose the option to save the graphic on
your hard drive. Some clip art sites have special download buttons along-
side the images, in which case you click the download button and follow the
onscreen instructions. After you download the clip art, you can insert the
graphic on your Web page by inserting into its Notepad file an image tag in
the form of <img src="filename.gif"> or <img src="file-
name.jpg">, depending on the filename extension.

HTML Tables and Web Page Layout

Compare the design of the Web pages illustrated in Figures 6-19 and 6-20.
How are they alike? Both contain pictures, and both contain text. How do
they differ? Figure 6-19 treats the screen as one large column of informa-
tion, whereas Figure 6-20 divides the screen into rectangular regions that
position the text and graphics in different sections of the Web page. Al-
though both screens convey the same information, you probably will agree
that the sectional layout of Figure 6-20 creates a more interesting Web
page. This chapter shows how to use tables to arrange information into
rows and columns on the screen. Then you will use tables to create a
unique design for your home page on the Web.

What Is a Table?

A table is a design element that divides the screen into a grid consisting of
rectangular regions called cells. Into each cell you can enter text or graph-
ics that align with the boundaries of the cell’s rectangle. The grid that

Internet Technologies at Work

note Tables became part of the
HTML standard when version 3.2 was
released in 1996. Web pages produced
before then were limited to a single
column of information.



forms the boundaries of the cells can be either visible or invisible. You nor-
mally make the grid visible when presenting a table full of technical infor-
mation that would be hard to read without horizontal and vertical lines to
help users follow the data across the table. HTML provides control over
border thickness, and you can use thin or thick grid lines, depending on the
situation.

Why Use Tables on Web Pages?

There are two reasons for using tables on Web pages. The first reason is
rather obvious—to present data neatly in rows and columns that help us-
ers perceive the order or the relationships in the information. This book
uses tables extensively to present complex information in an understand-
able manner. For example, consider the presentation of HTML tags that
appeared earlier in this chapter in Table 6-1. Displaying the tags in column 1
followed by their description in column 2 provides an orderly presentation
that enables readers to find a tag in column 1 and then read across to its
definition in column 2. The grid is visible to help you read across the table
to find the definitions of the different tags.
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FIGURE 6-19 How a Web page appears without the use of
tables to create rectangular layout regions on
the screen. �

FIGURE 6-20 Tables create rectangular regions used as design
elements in advanced Web-page layout. �
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The second reason for using ta-
bles on a Web page is to create ad-
vanced layouts consisting of
rectangular sections into which you
can flow blocks of text or insert
graphics. Tables consist of one or
more rows of one or more cells. You
can adjust the width and height of
the cells to create a wide variety of
Web page layouts. You can even
have more than one table on the
page at once, enabling you to create
many interesting designs. For ex-
ample, consider the layout of the
Web page shown in Figure 6-21.
The layout analysis in Figure 6-22
shows that this page consists of sev-
eral tables with varying numbers of
rows and columns and different cell
heights and widths. Notice how the
use of multiple tables adds interest
to the design of this page. You can
also vary the background colors or
images in the table cells to create
visible regions on the screen.

Creating a Table

You use three basic HTML tags to
create tables. First, the <table>
start and </table> stop tags be-
gin and end the table. Inside the
table, you use the <tr> start and
</tr> stop tags to begin and end
each row of the table. The code
<tr> stands for table row. Inside
each table row, you use the <td>
start and </td> stop tags to begin
and end each data cell. The code
<td> stands for table data. Inside
the table data cells, you put the tex-
tual and/or graphical content you
want in that cell of the table. Because
you can use a table to create any
conceivable layout of cells onscreen,
tables enable you to take control of
the page and position your content
exactly where you want it. On your

FIGURE 6-21 An advanced Web page design employing multiple tables with varying
cell heights and widths. �

FIGURE 6-22 Layout analysis of the tables used to create the Web page in
Figure 6-21. Notice how tables are nested inside of other tables. �



Web page résumé, for example, imagine you want your opening para-
graph and your bulleted table of contents to appear alongside your photo.
You can accomplish this by inserting a table after the heading that identi-
fies your name at the top of your résumé. This table should have one row
that contains two data cells. In the first data cell, you put your picture. In
the second data cell, you put the paragraph and the bulleted table of con-
tents you want alongside the picture. At runtime, because the picture ap-
pears in the table row’s first cell, the picture appears on the left of the text
you put in the second cell. If this sounds complicated, do not worry, be-
cause this is quite easily accomplished. To create this table in your résumé,
follow these steps:

1. Use the Notepad to open your Web page résumé, and position
your cursor after the </h1> tag that ends the heading that
identifies your name at the top of the page.

2. Type the following HTML code, which creates the table, its first
row, and its first data cell. For now, this code sets the table width
to 100%, causing the table to stretch all the way across the page.
Later in this tutorial, you learn how to change the width
attribute to create other layout possibilities onscreen.

<table width="100%">

<tr align="left" valign="top">

<td>

3. Position your cursor at the spot where you want the first data cell
to stop. In this example, click to position your cursor after the
<img> tag that puts your picture onscreen. Then type the following
code, which ends the first data cell and begins the second one:

</td>

<td>

4. Position your cursor at the spot where you want the table to stop.
In this example, click to position your cursor after the </li> tag
that ends your résumé’s table of contents. Then type the following
code, which ends the data cell, the table row, and the table:

</td>

</tr>

</table>

5. Save the file, and then open it with your browser to view how it
will appear on the Web. Your picture should appear on the left,
with your résumé’s opening paragraph and table of contents
alongside your image.

6. If you would like to see the table’s edges onscreen, you can give
the table a border. To do so, use the Notepad to modify the
<table> tag as follows:

<table width="100%" border="1">
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7. Save the file, and then view it with your browser to see the table’s
edges. Remember to click the browser’s Refresh button to make
sure you are viewing the current version of the file.

8. After you finish looking at the border, you will probably want to
go back into the Notepad and remove the border="1" attribute,
or set its value to zero to remove the table’s border. Normally you
turn on a table’s borders only when you need the lines to show to
help viewers follow straight across a row of data onscreen. When
a table is used for layout purposes, on the other hand, you keep
the borders turned off.

Adjusting the Attributes of a Table

The table you put in your Web page résumé has one row containing two
cells. This is just one of the design patterns you can create with tables,
which enable you to create any conceivable page layout onscreen. Con-
sider the following table structure, which has three rows:

L 6-3 <table>

<tr>

<td> row one, cell one </td>

<td> row one, cell two </td>

</tr>

<tr>

<td> row two, cell one </td>

<td> row two, cell two </td>

</tr>

<tr>

<td> row three, cell one </td>

<td> row three, cell two </td>

</tr>

</table>

Tables with more cells in a row than this example have more <td>
</td> tags. Tables with more rows have more <tr></tr> tags. There is
no limit to the number of design patterns you can create. In addition to cre-
ating different design patterns, you can use formatting and alignment
attributes to change the appearance of the table’s rows and cells onscreen.

Formatting Attributes

Attributes added to the table tag modify the table’s formatting. You have
already experienced how the border attribute causes the table to have a
border; for example, if a table has a border thickness of 2, the tag is
<table border="2">.

Alignment Attributes

The align attribute can modify the <table>, <tr>, and <td> tags to
control horizontal alignment. Values of the align attribute can be left,

Internet Technologies at Work



center, right, or justify, which means to double-justify the text. For exam-
ple, a table cell in which the data is right-justified has the tag <td align=
"right">. The default value is left.

The valign attribute controls vertical alignment. Its values can be top,
middle, or bottom. For example, a table cell in which the data aligns with
the bottom of the cell has the tag <td valign="bottom">. The default
value is middle.

To control both horizontal and vertical alignment, you can specify both
align and valign attributes. For example, a table cell in which the data
is right-justified at the bottom of the cell has the tag <td align=
"right" valign="bottom">.

Cell Spacing and Padding

By default, the table cells fit fairly close against the data they contain. If
you are displaying textual data, you will usually want to create a little
more cell spacing or padding. Cell spacing is the amount of space the
browser puts between the borders of the cells. Cell padding is the amount
of white space the browser puts inside the borders of the cells. You set cell
spacing and padding via the following attributes, which can be either inte-
ger values or percentages of the table’s width:

L 6-4 <table cellspacing="5" cellpadding="10%">

Coloring Tables and Cells

Sometimes you may want a table, a row, or a cell to have a background
color. You can create colored table backgrounds with the bgcolor attrib-
ute. For example, if you want the background to be silver, you can make
the table tag say <table bgcolor="silver">. This is just one of 16
defined color names, which are listed in Table 6-2. You can also specify
colors by hex codes, with which you can mix 16 million different hues. The
format is #RRGGBB where RR is the red value, GG is the green value, and
BB is the blue value. For example, <table bgcolor="#000080"> cre-
ates a navy blue background because it has such a lot of blue (80) but no
red or green in it. The highest color value is white, which is #FFFFFF. Note
that in the hexadecimal notation used for these color values, there are 16
numbers that range from 0 through 9 followed by the letters A (which is 10)
through F (which is 15). These letters are not case-sensitive in HTML. Hex
values for the commonly used hues are linked to this book’s Web site. You
can also find out the hex value of any color by using Paint Shop Pro. Sim-
ply double-click the foreground or background color swatch to open the
color picker dialog. Then click to select any color on the color wheel, and
the hex value will be shown in the HTML field in the lower-right corner of
the color picker.
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Sets the amount of spacing you want between the cells.

Specifies the amount of padding you want inside the cells.



To color an individual table
cell, you can edit the <td> tag
that begins that cell. To color a
cell, you once again use the
bgcolor attribute. To make a
cell’s background color bright
red, for example, you would type
<td bgcolor="#FF0000"> to
turn on maximum red (FF) fol-
lowed by no red or green (0000).

Remember that whenever you
create a colored background for
text, you must choose a color that
does not detract from the read-
ability of the text. Pastel colors
such as pastel yellow (#FFFFCC)
and pastel blue (#CCFFFF) work
well behind dark text. The mod-
ern trend, however, is to make
most of your text black on a white
background, for maximum read-

ability. Save the colors for special effects. Remember that a table can con-
tain multiple colors. In cells that contain text, you can make the
background “white” while using other colors in the <table> tag or in
other nontext table cells.
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Color Name RGB Color Name RGB

Black #000000 Green #008000

Silver #C0C0C0 Lime #00FF00

Gray #808080 Olive #808000

White #FFFFFF Yellow #FFFF00

Maroon #800000 Navy #000080

Red #FF0000 Blue #0000FF

Purple #800080 Teal #008080

Fuchsia #FF00FF Aqua #00FFFF

TABLE 6-2 Color Names of the Sixteen Predefined HTML Colors �

note In the latest version of
HTML, color attributes are deprecated.
Instead, developers are encouraged to
use style sheets. Chapter 8 shows you
how to do this. Billions of Web pages
continue to use HTML color attributes,
however.

Make a Table of the World’s Highest Mountains
An excellent way to reinforce your knowledge of HTML table commands is to create an actual table onscreen.
After you code the table, you can experiment with different values to see how the table data looks centered,
left-justified, or aligned to the right of the cells. By trying different vales for the border thickness and cell spac-
ing, you learn how to adjust these attributes to achieve different table effects onscreen. This exercise steps you
through the creation of a table that displays the world’s six highest mountains. As illustrated in Figure 6-23,
this table has four columns. The first column identifies the name of the mountain, the second column tells
what country the mountain is in, and the third and fourth columns tell how high the mountain is in feet and
meters, respectively. To create the HTML code for this table, follow these steps:

1. Pull down the Notepad’s File menu and choose New to begin a new file. Type the following HTML
to get the table started:

<html>

<head>

<title>World's Highest Mountains</title>

</head>

<body>

<h1>Six Highest Mountains</h1>

Try This!
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<table border="1" cellpadding="5" cellspacing="1">

<tr align="center" valign="middle">

<td><strong>Mountain</strong></td>

<td><strong>Country</strong></td>

<td><strong>Feet</strong></td>

<td><strong>Meters</strong></td>

</tr>

</table>

</body>

</html>

2. Pull down the File menu, choose Save As, and save the file as mountains.html in your website folder.
Then open the file with your browser and see if the first row of the table appears onscreen as
illustrated in Figure 6-23, except for the color, which you add in step 6. If you do not see the first
row of the table, go back to the previous step, proofread your code carefully, and troubleshoot any
problems until you get the first row working.

3. Click to position your cursor in the Notepad file after the table row you typed in the previous step
but prior to the </table> stop tag. Type the following code to create the second row of the table;
then save the file and view it with your browser. Click the browser’s Refresh button to make sure
you are viewing the current version of the file.

<td>

<strong>Meters</strong>

</td>

</tr>

<tr align="center" valign="middle">

<td>Everest</td>

<td>Nepal/China</td>

<td>29028</td>

<td>8848</td>

</tr>

</table>

</body>

</html>

4. There are five more mountains to add to the table. For each of these mountains, repeat the process
you followed in the previous step, substituting the specific mountain’s data as provided in Figure 6-23.
When you complete all the mountains, your table will appear as illustrated in Figure 6-23.

5. Experiment with different cellpadding and cellspacing values to get a feeling for what they do to the
table. Set cellpadding=“50” for example, and observe what effect that has on the table. Then set
cellpadding back to 5, and set cellspacing=“50” to compare how it works. Remember that each time
you make a change, you must save the Notepad file and then click the browser’s Refresh button to
view the latest version of the file.

6. Use the bgcolor attribute to put different colors into the background of the table. Remember that
you can apply the bgcolor attribute to the <table>, the <tr>, or the <td> tags, depending on

Try This!
continued
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Indenting to Document the Structure of a Table

When you use tables to control the layout of a Web page, you should form
the habit of indenting your table tags to show the document’s structure.
The browser ignores these indentations at runtime, so they will not affect
your page’s appearance. When you later need to edit or update something
on your page, however, you can use the indentations to find more quickly
the place in the document where you want to make your change. Consider
how the indentations in the following example make this code easier to
maintain than if you typed everything in a constant stream:

whether you want the color to apply to the entire
table, the row, or a single data cell. You can pick
color values from Table 6-2, but remember that if
you want the text to be readable, lighter colors
such as pastel yellow (bgcolor=“#FFFFCC”) and
pastel blue (bgcolor=“#CCFFFF”) work better
than the darker colors. Figure 6-23 shows how I
striped the table with alternating rows of white
and pastel yellow.

FIGURE 6-23 The World’s Highest Mountains. After you complete the Try This! exercise to get this table onscreen,
experiment by making the borders thicker or thinner. Give some of the table rows pastel background colors,

and experiment with centering, left-justifying, and right-aligning the table data onscreen. You will discover the power of tables for
creating all kinds of layout possibilities onscreen. �

L 6-5 <table>

<tr>

<td>

This is the content of the first cell of the table. The indentations of the tags

make it easier to find the location of this cell than if the document were typed

in a continuous stream of characters.

</td>

<td>

This is the content of the second cell of the table. Because the browser ignores

the tabs and spacing between the tags, you can thus indent your HTML without

affecting the appearance of your page on the Web.

</td>

</tr>

<tr>

<td>

Try This!
continued



Subdividing Table Cells

You can subdivide any table cell by creating a table inside a cell. Putting a
table inside a cell provides another layer of structure on the Web page.
There is no limit to the number of cells you can subdivide. Because subdi-
viding cells enables you to create any conceivable pattern of rectangular
regions on the screen, it provides an unlimited array of possibilities for lay-
ing out Web pages. Figures 6-24 to 6-27 show layout analyses of Web
pages that use subdivided table cells as design elements. To subdivide such
a table cell, you simply create a new table inside it. Here is an example:

L 6-6 <table>

<tr>

<td>

Outer table, row one, cell one.

</td>

<td>

<table>

<tr>

<td>

Inner table, row one, cell one.

</td>

<td>

Inner table, row one, cell two.

</td>

</tr>

</table>

</td>

</tr>

</table>
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Notice how the indentations make the start of a new row especially easy to find.

</td>

<td>

I highly recommend this method of indenting your HTML table code. It takes hardly

any time at all to press the indent key, but it can save you a lot of time later

when you need to update your page or delete something.

</td>

</tr>

</table>
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FIGURE 6-24 This Web page has a table inside a table. This
kind of design lets you create a design structure

for one cell that functions independent of the cells in the outer table. �

FIGURE 6-25 Layout analysis of Figure 6-24. Study this
analysis to visualize how the tables

provide the structure for the page content in Figure 6-24. �

FIGURE 6-26 This Web page is built by using one large outer
table, a smaller table nested inside that one, and

still smaller subtables inside that. Nesting tables in this manner enables
you to create any conceivable page layout of content onscreen. �

FIGURE 6-27 Layout analysis of Figure 6-26. Study this
analysis to visualize how the tables provide

the structure for the page content in Figure 6-26. �



Making Cells That Span More Than One Row or Column

By default, each cell in a table is confined to just one row and column. To
vary the layout of a table, you can expand a cell to make it span more than
one row or column. To do so, you give the cell’s <td> tag a rowspan or
colspan attribute. For example, a cell that spans two rows and three col-
umns has the tag:

L 6-7 <td rowspan="2" colspan="3">

HTML Hyperlinks and Web Design

In this chapter, you learned how to create HTML hyperlinks that either
link to another Web page or provide users with a way to jump around to
different places on a Web page via named anchor bookmarks. Any page on
the Web can be the target of such a link. Now that you have this capability
to link to other pages, it is appropriate to reflect on how links form Webs
and how those Webs can have shapes that follow the five basic hypermedia
design paradigms.

How Links Form Webs

Think about how a spider weaves a web. No matter how complicated the
web turns out to be, each path gets created by the spider’s creating a link
from one spot to another. In technical networking jargon, these spots are
called nodes. Out on the World Wide Web, your pages work like nodes.
You can link any page to any other page, depending on the kind of naviga-
tional possibilities you want to provide. Just as the spider’s web has a cer-
tain shape depending on how the spider connects its nodes, so also does
your Web take on a shape, depending on the kinds of patterns you use in
your linkages.

Chapter 6: HTML Coding

Linking Your Home Page to Your Résumé Page
The simplest kind of hypermedia shape is formed by linking two pages together. If you have never done this be-
fore, you will understand the process better if you create such a link. Earlier in this chapter, you created a Web
page called resume.html. In this exercise, you add to the résumé page a link to your home page. If you do not
already have a home page, this is an excellent time to get one, and these instructions will coach you. To create a
link to your home page, follow these steps:

1. Use the Notepad to open the resume.html page you created earlier in this chapter. Click to position
your cursor at the spot where you would like to provide an option for users to go to your home
page. A good place to put such a link is next to the return-to-contents links that you put at the end
of each section of your résumé. If you do not have a home page yet, you still can create the link.
Home page instructions come later in this exercise.

Try This!
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2. At the spot where you want to put the option to go to your home page, type the following code,
which will create such a link. In the href attribute, if you already have a home page out on the
Web, type the HTTP address of your home page. If you do not have a home page yet, simply type
index.html as a placeholder for the home page you will create later in this chapter. To create the link
to your home page, type this code:

<a href="http://www.northpole.com/santa/index.html">Go to my home page</a>.

3. Save the Notepad file and open it with your browser to see how your link appears onscreen. If it
does not appear quite like you want, use the Notepad to fine-tune its appearance. Then save the file
and click your browser’s Refresh button to view the modified version of your page.

4. If you have a home page, click the link to go to your home page to see if the link works properly.
Congratulate yourself heartily if the link works. If the link does not work, repeat the steps in this
exercise more carefully, and keep trying until you get the link to work.

5. If you do not yet have a home page on the Web, you should start one. In this chapter, you have
learned all the HTML codes you need to create a very attractive home page. To create a home page,
you simply use the Notepad to create a new file. Into this new file, type the minimum HTML that is
needed to create a Web page. For a home page, that HTML would read as follows:

<html>

<head>

<title>Santa Claus's Home Page</title>

</head>

<body>

The text and graphics of your home page go here. The design is totally up to you.

Remember that home pages are normally short. The purpose of a home page is to

establish your identity and provide links that visitors can click to learn more

about you. See, for example, my home page at www.udel.edu/fth.

</body>

</html>

6. When you save your home page, put it in your website folder and give it the filename index.html.
This is the default filename that comes up at a Web site if you go to the site’s HTTP address without
specifying a specific filename. You can go to my home page, for example, by going to www.udel.edu/
fth, which automatically brings up the default file at www.udel.edu/fth/index.html.

7. If you save your home page as index.html in the website folder in which your resume.html file also
resides, the link you type in step 2 of this exercise can simply read as follows:

<a href="index.html">Go to my home page</a>.

8. If you do not yet know how to publish pages on the World Wide Web, you are probably anxious to
do so. Chapter 7 contains a complete Web page publishing tutorial that shows how to publish pages
into your Web space. You will also find out how to get free Web space, in case you do not yet have a
Web account for publishing your pages.

Try This!
continued
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Hypermedia Design Paradigms

Whenever you link two or more Web pages, you create a hypermedia de-
sign that can be visualized. The extent to which you can visualize your
webs determines how successful you will be in planning the navigational
pathways users can traverse at your Web site. The goal is to provide your
users with navigation options that are both appropriate and quick. Users
get frustrated if they need to click more than three or four times to find the
information they are looking for. If you can visualize your site’s design,
you can foresee pages that will take too long to click through. Then you
can add links that create new pathways to these pages.

My Multimedia Literacy textbook, which is also published by McGraw-
Hill, identifies five design paradigms you can use to create these kinds of
links. This chapter concludes by presenting these five design paradigms.
Your challenge is to reflect on these five paradigms and try to imagine if
there might be some web design that they cannot describe. If you can think
of a way of linking pages that cannot be described by these five paradigms,
you may well have invented a new paradigm.

The five design paradigms are the linear list, the menu, the hierarchy,
the network, and the hybrid.

Linear List

The simplest design is the linear list paradigm illustrated in Figure 6-28.
The linear list is a hypermedia design paradigm that enables users to move
back and forth through a serial sequence of pages, moving forward to new
materials or backward to review. The linear list is most appropriate for situ-
ations in which you want to show a sequence of pages in a slideshow format.

Menu

The second way to design a navigational pathway is
to create a menu like the one shown in Figure 6-29.
A menu paradigm is a hypermedia design pattern
that permits users to select one from a number of
choices listed onscreen. When the user chooses an
item on the menu, the item linked to it appears.

Hierarchy

The third kind of design is the hierarchy paradigm
shown in Figure 6-30. A hierarchy is a
hypermedia design paradigm in which each ob-
ject provides users with a menu of choices that trigger more menus with
more choices. There is no limit to the size or number of menus and

FIGURE 6-28 The linear list lets users move forward to see new pages or backward to
review. This paradigm is appropriate for sequences of Web pages that

you want users to view in a slideshow manner. If the sequence is long, however, you will also want
to provide a link to the menu so users can jump out of the slideshow if they lose interest. �

FIGURE 6-29 The menu design presents users with a set of
choices. In this example, the menu lets users begin

one of three possible sequences of Web pages. Each sequence ends by
going back to the menu, from which users can make another choice. �



submenus you can have in such a
hierarchy. Large Web sites typi-
cally use a hierarchy to provide a
way for users to drill down to the
information they want.

Network

The most complicated design is the
network shown in Figure 6-31.
The network paradigm is a
hypermedia design pattern in
which objects can be multiply
linked in any direction to any ob-
ject in your web. Especially when
a web is large, the network design
enables users to navigate to any
page with a minimum of mouse
clicks. A tight design enables us-
ers to get wherever they want
within three clicks.

Hybrid

Web sites often use more than one
design paradigm, employing lists,
menus, hierarchies, and networks
where appropriate. For example,
a sophisticated network design
may trigger a linear list with sim-
ple navigation that lets users
move back and forth through the
pages as in a slideshow. When a

user gets to the end of the list, the network design returns to
provide richer navigation options. Designs that combine
paradigms are called hybrids. Figure 6-32 shows an exam-
ple of a hybrid paradigm, which is a hypermedia design
paradigm that provides multiple navigational pathways by
employing linear lists, menus, hierarchies, and network de-
signs as appropriate throughout a large Web site.
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FIGURE 6-30 The hierarchy presents users with a menu of menus. If you have a large
Web site with dozens or hundreds of pages, the hierarchy enables you to

design pathways through which users can drill down to the desired page. �

FIGURE 6-31 The network paradigm contains multiply
linked items that provide the richest kind

of navigation. Users can find a way to get anywhere they want in
this web within three clicks. You should use this design whenever
you need to provide alternate pathways through a complex web.
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FIGURE 6-32 Hybrid designs employ linear lists, menus, hierarchies, and networks where appropriate.
If you think about the World Wide Web as a whole, its design represents the ultimate in

hybrid hypermedia construction. �

Linear List

Menu

Hierarchy

Network



Chapter 6 Review

■ Chapter Summary
After reading this chapter and completing the step-
by-step tutorials and Try This! exercises, you should
understand the following facts about the Internet:

How HTML Works

� HTML is the markup language used to create
hypertext documents for the World Wide Web.
HTML stands for hypertext markup language.
The key to understanding how HTML works is
to know what it means to mark up a text.

� To mark up a text means to insert special codes
called tags into the text. The tags control how
the text appears on a Web page.

� There are two HTML tag formats: paired tags
and single tags. Paired tags come in pairs that
consist of a start tag and a stop tag. Single tags
function on their own with no stop tag.

� HTML has progressed through several versions,
each of which added new functionality to what
you can do on a Web page. However, HTML
did not follow strictly the rules of its parent
language, which is the standard generalizable
markup language (SGML). To tighten up the
HTML language and make it compatible with
newly emerging XML tools, the W3C created a
new language called XHTML.

� Pages authored in XHTML will render not only
on the Web but also on pagers, PDAs, cell
phones, tablet PCs, and other devices that are
following the new XML-based wireless
protocols. XHTML pages can also be mined by
XML tools as data that can be used in server-to-
server and business-to-business applications.

Creating Your Web Page Résumé

� An HTML document begins with the <html>
start tag and ends with the </html> stop tag.
Between those tags come the <head> start and
</head> stop tags, followed by the <body>
start and </body> stop tags.

� You create the Web page title via the <title>
start and </title> stop tags, which go
between the document’s <head> and </head>
tags. The title you type between the <title>
and </title> tags will appear in the browser’s
title bar when someone visits the page.

� Heading styles cause the headings on a Web
page to appear in progressively larger fonts,
depending on the level of the heading. The
smallest heading style is H6, and the largest is
H1. In addition to making the text larger,
heading styles create a structure that can be
used to outline the document. You should use
heading styles whenever a document has this
kind of an outline structure. To create a heading 1
style, for example, you type the heading
between the <h1> start and </h1> stop tags.

� You create paragraphs on a Web page by typing
the text between the paragraph <p> start and
</p> stop tags. Although the browsers will
forgive the omission of the </p> stop tag, the
rules of XHTML, if strictly enforced, require
every start tag to have a corresponding stop tag.
Thus, you should form the habit of including
the </p> stop tag at the end of each paragraph.

� You create lists with the unordered list <ul>
start and </ul> stop tags for a bulleted list or
the ordered list <ol> start and </ol> stop tags
for a numbered list. Between these tags, you
type the list items, which must begin and end
with the list item <li> start and </li> stop
tags. Although the browsers will forgive the
omission of the </li> stop tag, the rules of
XHTML require its presence, so you should
include it.

� Horizontal rules create neat-looking dividing
lines between different parts of a Web page. You
create a horizontal rule by typing the <hr> tag
at the spot on the page where you want the rule
to appear. The <hr> tag is a single tag which,
by definition, does not have a corresponding
stop tag.
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� You create bookmark names with the anchor
tag, which has the format <a name=
"bookmarkname"></a>. In typing this
command, you replace bookmarkname with the
actual name you want the bookmark to have.

� You create links to a bookmark via the anchor
tag by using the format <a href=
"#bookmarkname>Click Me!</a>. In typing
this command, you replace bookmarkname with
the actual name of the bookmark, and replace
Click Me! with the hypertext that will appear
onscreen.

� To link one Web page to another, you type an
anchor tag by using the format <a href=
"http://www.udel.edu">University of
Delaware</a>, and replace the Delaware
information with your link’s actual HTTP
address and hypertext.

� Netiquette calls for Web pages to end with a
few lines of text indicating who owns the page
and how to contact the owner. A mailto is a link
that, when clicked, opens a new message
window addressed to the person identified in
the link. It is customary for Web page owners to
include a mailto link to their e-mail address to
make it easy for you to contact them. The
format is:

L 6-8 <a href="mailto:santa@northpole.com">

santa@northpole.com</a>

� To create white space on a Web page, you use
the <p> and </p> tags to begin and end a
paragraph. To end the current line and move to
a new line, you use the <br> break tag. To
create a single white space onscreen, you use the
&nbsp; space code, which can be used to
display simultaneous white spaces onscreen, as
in &nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.

� To make text appear bold on a Web page,
you surround it with the <strong> start and
</strong> stop tags. To italicize something,
you surround it with the emphasis <em> start
and </em> stop tags.

� Resist the temptation to press the ENTER key
repeatedly to add white space in an attempt to

create pagination on a Web page. If you want a
new page, create a new Web page and link to it
from a hypertext link or a navigational icon.
Otherwise, just let your text flow onto the
screen so users can scroll down to peruse it,
uninterrupted by feigned white-space paging.

HTML Graphics and Animated GIFs

� Web page images should be in either the GIF or
JPEG file format. You can also use the relatively
newer PNG format discussed in Chapter 2.
Paint Shop Pro is a Windows program you can
use to convert images into the proper format.
You can also use Paint Shop Pro for image
capture, creation, viewing, and manipulation.
A try-before-you-buy version lets you try Paint
Shop Pro free for 60 days before deciding
whether to purchase the software.

� To convert an image with Paint Shop Pro to a
different file format, you use the File | Save As
dialog, which has a Type field that lets you
choose the format in which to save the
converted file.

� Although you can make an image appear
smaller by dragging its handles in a WYSIWYG
Web page editor, this does not reduce the file
size of the image and therefore consumes more
bandwidth than a truly resized image. Paint
Shop Pro has an Image | Resize option that
enables you to reduce the actual size of the
image, thereby saving valuable bandwidth.
When you resize an image, you should choose
the option to lock the aspect ratio so the image’s
dimensions do not distort and cause the picture
to appear too thin or too short.

� Unless you have a special reason for keeping
your images encoded in 16 million colors (24-
bit format), you should convert the images to
256 colors (8-bit format), which will make them
appear three times faster on your Web page due
to the smaller file size.

� A background tile creates a special effect by
drawing an image repeatedly across and down
the screen until the entire window has been
covered. If the image is designed in such a way
as to hide the edges when tiled, you get a
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seamless appearance in the background. If you
plan to display printed text on the tiled
background, be sure to choose a tile that will
not interfere with the readability of your text.

� Transparency is a special effect in which one
of the colors in a bitmap becomes translucent.
Instead of seeing that color, you see through
it into the background color or image on the
screen.

� An animated GIF is a graphic that contains
multiple images intended to be shown in a
sequence at specific times and locations on the
screen. A looping option causes your Web
browser to keep showing the frames in the GIF
file continually, and, as a result, you see an
animation onscreen.

� Clip art is pre-drawn artwork organized into
a catalog or library that you can browse in
search of appropriate icons, buttons, banners,
backgrounds, tiles, or animated GIFs for use
on Web pages.

HTML Tables and Web Page Layout

� A table is a Web page design element that
divides the screen into a grid consisting of
rectangular regions called cells. Into each cell
you can enter text or graphics that align with
the boundaries of the cell’s rectangle. Because
you can use a table to create any conceivable
layout of cells onscreen, tables enable you to
take control of the page and position your
content exactly where you want it.

� You use three basic HTML tags to create tables.
First, the <table> start and </table> stop
tags begin and end the table. Inside the
<table>, you use the <tr> start and </tr>
stop tags to begin and end each row of the
table. The code <tr> stands for table row.
Inside each table row, you use the <td> start
and </td> stop tags to begin and end each data
cell. The code <td> stands for table data. Inside
the table data cells, you put the textual and/or
graphical content that you want in that cell of
the table.

� Attributes added to the table tag modify the
table’s formatting. If you would like to see the
table’s edges onscreen, for example, you can
give the table a border. The tag format is
<table border="2"> for a border that is two
pixels thick.

� The align attribute can modify the <table>,
<tr>, and <td> tags to control horizontal
alignment. Values of the align attribute can be
left, center, right, or justify, which means to
double-justify the text. For example, a table cell
in which the data is right-justified has the tag
<td align="right">. The default value is left.

� The valign attribute controls vertical
alignment. Its values can be top, middle, or
bottom. For example, a table cell in which the
data aligns with the bottom of the cell has the
tag <td valign="bottom">. The default
value is middle.

� To control both horizontal and vertical
alignment, you can specify both align and
valign attributes. For example, a table cell in
which the data is right-justified at the bottom
of the cell has the tag <td align="right"
valign="bottom">.

� Sometimes you may want a table, a row, or a
cell to have a background color. You can create
colored backgrounds with the bgcolor
attribute. For example, if you want the
background of the entire table to be silver, you
can make the table tag say <table bgcolor=
"silver">. If you want an individual cell to
have a separate color, make the table data tag
say <td bgcolor="silver">. This is just
one of 16 defined color names, which are listed
in Table 6-2.

� You can also specify colors by hex codes, with
which you can mix 16 million different hues.
The format is #RRGGBB, where RR is the red
value, GG is the green value, and BB is the blue
value. For example, <table bgcolor=
"#000080"> creates a navy blue background
because it has such a lot of blue (80) but no red
or green in it. The highest color value is white,
which is #FFFFFF.



� Cell spacing is the amount of space the browser
puts between the borders of the cells. Cell
padding is the amount of white space the
browser puts inside the borders of the cells. You
set cell spacing and padding via the following
table tag attributes, which can be either integer
values or percentages

L 6-9 <table cellspacing="5" cellpadding="10%">

� When you use tables to control the layout
of a Web page, you should form the
habit of indenting your table tags to show
the document’s structure. The browser ignores
these indentations at runtime, so they will not
affect your page’s appearance. When you later
need to edit or update something on your page,
however, you can use the indentations to find
more quickly the place in the document where
you want to make your change.

� You can subdivide any table cell by creating a
table inside a cell. Putting a table inside a cell
provides another layer of structure on the Web
page. There is no limit to the number of cells
you can subdivide. Because subdividing cells
enables you to create any conceivable pattern
of rectangular regions on the screen, it provides
an unlimited array of possibilities for laying out
Web pages.

� By default, each cell in a table is confined to
just one row and column. To vary the layout
of a table, you can expand a cell to make it
span more than one row or column. To do so,
you give the cell’s <td> tag a rowspan or
colspan attribute. For example, a cell that
spans two rows and three columns has the tag
<td rowspan="2" colspan="3">.

HTML Hyperlinks and Web Design

� Whenever you link two or more Web pages,
you create a hypermedia design that can be
visualized. The extent to which you can

visualize your webs determines how successful
you will be in planning the navigational
pathways that users can traverse at your Web
site. The goal is to provide your users with
navigation options that are both appropriate
and quick.

� The linear list is a hypermedia design paradigm
that enables users to move back and forth
through a serial sequence of pages, moving
forward to new materials or backward to
review. This paradigm is appropriate for
sequences of Web pages that you want users to
view in a slideshow manner. If the sequence is
long, however, you will also want to provide a
link to the menu so users can jump out of the
slideshow if they lose interest.

� A menu is a hypermedia design paradigm that
permits users to select one from a number of
choices listed onscreen. When a user chooses an
item on the menu, the item linked to it appears.

� A hierarchy is a hypermedia design paradigm in
which each object provides users with a menu of
choices that trigger more menus with more
choices. If you have a large Web site with
dozens or hundreds of pages, the hierarchy
enables you to design pathways through which
users can drill down to the desired page.

� The network is a hypermedia design pattern in
which objects can be multiple linked in any
direction to any object in your web. Especially
when a web is large, the network design enables
users to navigate to any page with a minimum
of mouse clicks. A tight design enables users to
get wherever they want within three clicks.

� A hybrid is a hypermedia design paradigm that
provides multiple navigational pathways by
employing linear lists, menus, hierarchies, and
network designs as appropriate throughout a
large Web site. If you think about the World
Wide Web as a whole, its design represents the
ultimate in hybrid hypermedia construction.
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■ Key Terms Quiz
1. Loosely derived from SGML, _______________

is the markup language used to create hypertext
documents for the World Wide Web. A newer
version called ____________________ brings the
language into compliance with the stricter rules
of SGML and makes it compatible with newly
emerging XML tools.

2. To mark up a text means to insert special codes
called ____________________ into the text.

3. To create a(n) ____________________, you type
the <hr> tag at the spot in an HTML file where
you want this Web page element to appear.

4. In HTML, bulleted lists are known as
____________________ lists, and numbered
lists are called ____________________ lists.

5. A(n) ____________________ is a link that, when
clicked, opens a new message window
addressed to the person identified in the link.

6. To create white space on a Web page, you use
the <____> and <____> tags to begin and end
a paragraph, respectively.

7. To end the current line and move to a new line,
you use the <____> tag.

8. Web page images should be in either the
_________________ or ________________
file format. You an also use the relatively
newer ____________________ format.

9. A(n) ____________________ is a graphic that
contains multiple images intended to be shown
in a sequence at specific times and locations on
the screen.

10. A/an ____________________ is a Web page
design element that divides the screen into a grid
consisting of rectangular regions called cells.

■ Multiple-Choice Quiz
1. What tag marks the beginning of an HTML

document?
a. <body>
b. <head>
c. <html>
d. <start>

2. What tags do you use to create the page title?
a. <body> and </body>
b. <h1> and </h1>
c. <label> and </label>
d. <title> and </title>
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animated GIF (25)
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cell padding (31)
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clip art (26)
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linear list paradigm (39)
list item tag (4)
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page title (7)
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start tag (3)
stop tag (3)
table (26)
tag (3)
tile (24)
transparency (24)
unordered list (10)
XHTML (4)



3. Which syntax do you use to create a named
anchor bookmark?
a. <a name="bookmarkname"></a>
b. <a href="#bookmarkname>Click Me!</a>
c. <a href="http://www.udel.edu">

University of Delaware</a>
d. <a href="mailto:santa@northpole.com">

santa@northpole.com</a>

4. To make text appear bold on a Web page, you
can surround it with what pair of tags?
a. <bold> </bold>
b. <em> </em>
c. <emphasize> </emphasize>
d. <strong> </strong>

5. An image encoded in 16 million colors (24-bit
format) is about how many times larger than
the same image encoded in 256 colors (8-bit
format)?
a. Three
b. Five
c. Six
d. Twelve

6. In a table, the table data <td> start and </td>
stop tags go between what pair of tags?
a. <td> </td>
b. <tr> </tr>
c. <td> <tr>

d. <tr> <td>

7. Which attribute controls horizontal alignment
of a <table>, <tr>, or <td> table element?
a. Align
b. Colspan
c. Rowspan
d. Valign

8. Which hypermedia design pattern best describes
the design of the World Wide Web when
considered as a whole?
a. Linear list
b. Hierarchy
c. Network
d. Hybrid

9. What kind of a list is bulleted by default?
a. Linear
b. Linked
c. Ordered
d. Unordered

10. In HTML, how can you subdivide a table cell
into several more cells?
a. Create another table inside it.
b. Press ENTER to move down to the next line.
c. Press TAB to generate a new cell.
d. Use a <subdiv> tag.
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■ Essay Quiz
1. Go to www.w3.org/MarkUp and read how the World Wide Web consortium oversees the continued

evolution of HTML. What mechanism is provided by the W3C for you to request new features to be
added to HTML and XHTML?

2. This chapter got you started creating your Web page résumé. Now you should complete your résumé
by adding all the sections you sketched when you designed your résumé at the start of this tutorial.
If you have any trouble, refer to the step-by-step instructions in this chapter for creating new paragraphs,
headings, list items, and horizontal rules.

3. Each item in your bulleted table of contents should be linked to its corresponding section in your
résumé. Insert named anchor bookmarks at the beginning of each new section in your résumé. Then
link each item in your table of contents to the corresponding bookmark in your résumé. Test the
links to make sure they work. At the end of each section in your résumé, provide a way for users to
return to your table of contents.

4. Take any image and use Paint Shop Pro to increase its color depth to 16 million colors (24-bit format).
Inspect the file’s size with the Windows Explorer and make a note of how large the file is. Now decrease
the color depth to 256 colors (8-bit format). Inspect the file’s size again. By what percentage has the
size of the file decreased? Will this make the file appear more quickly when it gets downloaded from the
Internet for display on a Web page?
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5. This book’s Web site contains several images designed for use as tiles on Web pages. Download several
of these images, and try tiling them onto your Web page résumé. What is the filename of the tile that
appears best on your Web page résumé? Why do you like that tile better than the others?

Lab Projects

• Lab Project 6-1: Graphic Design
The adage that a picture is worth a thousand words has never been more appropriate than on a Web page.
One could argue that the hypermedia environment adds even more value to the picture because you can
access it quickly when you need it. Being able to find the picture you want quickly may make the image
worth a million words when it answers a question or solves a problem for which you need a solution quickly.
Imagine that your employer has put you in this kind of a situation. Your school or small company is having
budget problems, and your employer has asked you to develop a cost-effective strategy for creating Web site
graphics. Get your word processor started, and follow these suggested ways of satisfying your employer’s
request for a graphic design strategy:

■ Several good banner- and button-making utilities are available on the Web. See if you can find a utility
that creates banners and buttons in a style compatible with your school or company’s look and feel.
Follow this book’s Web site links to banner and button makers. Using your word processor, take notes
identifying the names of the sites you visited, and report whether you would recommend them for use in
your workplace. At the site you like best, create a sample banner and copy it into your report as an example.

Note: To copy a graphic from the Web into your word processor, right-click (Macintosh users
CONTROL-click) the image and choose Copy; then go into your word processor, pull down the
Edit menu, and choose Paste.

■ Paint Shop Pro has a button-maker built in. Make a sample button with Paint Shop. Copy the button into
the report in your word processor, and write a paragraph indicating that the button came from Paint
Shop. State whether you would recommend using the Paint Shop button maker to make buttons at your
school or company Web site.

■ FrontPage has a wide array of themes built in. If you are using FrontPage, you can audition these themes
to see if there might be one suitable for use in your school or company. It is also possible to modify the
FrontPage themes; if you find one that almost fits, you can fine-tune it. To audition the FrontPage themes,
follow these steps:

1.In FrontPage, click the New Page button to create a new page.

2.Pull down the Format menu and choose Theme; the Themes dialog appears.

3.In the list of themes on the left, click the theme you would like to see. The theme appears in the window
on the right. Repeat this step and look at all the different themes.

4.If you see a theme you like, use your word processor to record its name in the report you are writing.

■ The Microsoft Clip Gallery is a rich source of graphics for illustrating Web pages. Follow this book’s
Web site link to the Microsoft Clip Gallery, and use the search tools to perform a keyword search
for the kinds of graphics needed by your school or company. Use your word processor to add to your
report any suitable graphics you may find. Type the graphic’s filename, and paste a thumbnail of the
graphic into your report.
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If your instructor has asked you to hand in this assignment, make sure you put your name at the top; then
save your graphic design recommendations on disk or follow the other instructions you may have been given
for submitting this assignment.

• Lab Project 6-2: Page Layout
Page layout is a critical aspect of creating a Web site for any school or business. Because of the different screen
sizes in common use today, you need to plan a design that will adjust to different window sizes. Every site
on the Web faces this dilemma. Imagine that your employer has noticed that some Web sites seem to have
better layout than others. Your employer has asked you to go out on the Web, analyze the designs of some of
the better sites, and recommend a page layout strategy for your school or company Web site. To complete
this assignment, follow these steps:

1. Visit some of the premier sites on the Web and observe how they lay out material on their Web pages.
Sites with innovative screen layouts include:

a. www.microsoft.com

b. www.cnn.com

c. www.amazon.com

d. www.sony.com

e. www.macromedia.com

f. www.msn.com

2. At each of the sites you visited in step 1, resize your browser window and refresh the pages to see how
they look at different screen resolutions.

3. All of these sites use tables to define their screen layout. As you learned in this chapter, tables permit
you to design any conceivable layout pattern onscreen. One of the tricks you can use is to define certain
columns of a table to be fixed to a predetermined pixel size, and set the others to a certain percentage of
the window’s width. When a user resizes the window, the columns that have percentage settings stretch
or squeeze accordingly. Consider whether this kind of a design would be appropriate for your Web site.

4. At the microsoft.com site, notice especially how the menu bar at the top stretches or squeezes to fit the
window when you resize your browser. Decide whether you want the menu bars at your site to work
like this.

5. Use your word processor to write a three-part report, organized as follows:

a. In the first part, describe the screen layout strategy you recommend for your workplace. If you
found other Web sites by using this strategy, provide their Web addresses so your employer can go
visit them to see what you mean.

b. In part two, write a paragraph or two describing sites you found interesting but whose layouts you
rejected. Give the Web addresses so your employer can visit them, and state why you decided not to
follow their designs.

c. In the third part, conclude your report with a brief paragraph stating why the solution you have
recommended is better than the layouts you decided to reject.

If your instructor has asked you to hand in this assignment, make sure you put your name at the top; then save
your page layout recommendation on disk or follow the other instructions you may have been given for submit-
ting this assignment.




